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» User Interface Navigation
 Starting from a Template
* Project View

 WBS Properties

» Adding Cost

 Alternates

* Fee Table

» Reports/Dashboard

* Version Estimate
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. Overview of the Concept of Templates

o Starting Point of New Estimates
o Market Specific
o Hard bid vs. CM

. Key Elements

o Key Project Metrics

o Standard Fee Table

o Standard Estimate View Layouts

o Standard Estimate Filter Groupings
o Highlight Rules

o 0 Quantity Line Items

. Select Appropriate Template

o Click New Estimate From Template
o Enter Estimate Name

o Enter Client Data - Optional
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\Interface Management

General Navigation
Unhide/Auto-hide views

Dock/Float views

Right click/select option
Double LMB click
Click/Drag

Reset Views
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. Historic Markers

o  Used for Cost History purposes
o  Examples

= Market Sector

= Owner

s Designer

. Key Metrics

o  Forusein Cost Per analysis or quantification
o  Examples

= Total Building Area

s Total Site Area

s Construction Duration

= Number of Keys (for hotel)

= Number of Spaces (for garages)

- Market Sector



. Assign Values

o

o

o

o

o

o

Level of Detail -> SD

Vertical Market -> Commercial

Project Type -> Office

Construction Type -> New Construction
Construction Duration -> 24

Precon Duration-> 12

. Link & Assign Values

o

o

Total Building Area -> 100,000
Total Site Area -> 300,000

SscCK TeCH
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. Review Cost Database WBS Properties
- UF, MF, CSI, Bid Package, etc.
. Estimate Level WBS Properties
- System
Add values - (Blank), “Building 1” and “Site"
. "Set as Sticky WBS"” — DEFINE
- Check this box for System WBS

. Can create/use unlimited number of WBS properties
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. Cost Database View
- Establish desired Groupings
Setup MF 1-3 grouping
Save configuration
. Add line items to estimate
- Add 1 line item at a time

(Toggle on WBS in CIV)
Single click “015419.0110 - Equipment rental; crane; 15 ton capacity; by week” from Cost Database

Set System to “Building 1" in Cost Information View
Qty =12 wk

Equip Cost = $3,500

Add to Estimate
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« Add line items to estimate [cont'd]
o Drag and Drop Line Item
= Drag/Drop “015433.0195 - Equipment rental; bulldozer; 200 hp; by week”

= Since System is Sticky, Building 1 is automatically assigned
« Qty =40 wk
= Equipment Cost = $6,600

o Use Find Feature in Cost Database

o Click on the magnifying glass to search for the highlighted items below:
. 015213.0100 - Trailer; general office type” — Qty = 24 mo in estimate view
. "015713.0110 - Sediment fence, 36" fabric with 6" mesh” — Qty = 1,000 If in estimate view
. 015713.0100 - Straw bale secured with rebar” — Qty = 500 If in estimate view

= Drag/drop these line items to Estimate View

= Since System is Sticky, Building 1 is automatically assigned
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e Add line items to estimate [cont'd]

o  Shopping Cart Bulk Add line items

= Select “01 31 00 Project Management and Coordination” folder in cost database
= Use Cost information View to move these line items into your “cart”

e 013113.0100 - Superintendent

o« 013113.0105 - Field engineer

e 013113.0110 - Foreman
= Addto estimate
= Assign Quantities and Costs

013113.0100 - Superintendent

o Quantity =2 yr
o Unit Cost = $137,500
013113.0105 - Field engineer

o Quantity =2 yr
o Unit Cost = $125,000
013113.0110 - Foreman

o Quantity =2 yr
o Unit Cost = $§117,500
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Filter Tree
- Establish MF 1-3 Grouping
- Save grouping
- Select different values in filter to see how estimate view changes
- Reminder: [All Items] is your “home base”
Estimate Layouts
- Review existing layouts — try them out!
- Use Column Chooser to introduce new columns

- Save New Layout (See next slide)
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Q. Create one!

Home Project Estimate  Rates & Resources  Dashboard Insert  View Comparison  Takeoff

=]| - [ J Remove Cost . i'"y ’ﬂ Default
Copy Line ltem Feras ) ]
Save 3 Refresh Create One-off Set Fees  WES Highlight Audit From Estimate Upload to = Create

Changes Line [tem Escalation Properties Rules Trail View= Financials = Project

Estimate Line |tem Other Excel Report Rate Tables Procore Bid Day

Estimate

13314

Estimate Layouts: | LMSEQ

_\
-

‘ Masterformat Level 1 =+

‘ [tem Number Description CQuantity | Unit... | Labor Cost Total Labor Cost Material Cost Total Material Cost | Sub Cost Total Sub Cost Equipment Cost Total Equipment C... | Other Cost Total Other Cost Unit Cost |Aggregate Cost
4 $£3.394,625.00 »

4 010000 GENERAL REQUIREMENTS $3,394,625.00 »
01300.010 | Aerial project photos 29,00 §1,000.00 §20,000.00 §1,000.00 §29,000.00
01300.020 | Airfare 10,00 §1,200.00 $12,000.00 §1,200.00 $12,000.00
07300.040  Assistant project manager 29,00 $5,500.00 $150,500.00 $5,500.00 §159,500.00
07300.050 | Eim coordinator 29.00 §6,500.00 $188,500.00 $6,500.00 §1838,500.00
07300070 | Cell phone 29.00 §100.00 §2,900.00 §100.00 §2,900.00
07300.090 | Estimator 29,00 §8,000.00 §232,000.00 $8,000.00 §232,000.00
01300.100  Field accountant 29,00 §5,000.00 §145,000.00 §5,000.00 §145,000.00
01300110 | Field engineer 29,00 $6,500.00 $188,500.00 $6,500.00 §188,500.00
07300120 | Foreman 29.00 §6,500.00 §188,500.00 $6,500.00 §183,500.00
07300.160  Matenals testing 10,000.00 | sf 55,00 $50,000.00 §5.00 $50,000.00
01300170 Mileage 29,00 5450.00 $13,050.00 §450.00 $13,050.00
01300.180 | Per diem 1,000.00 §100.00 §100,000.00 £100.00 £100,000.00
01300210 | Postage service 29,00 §75.00 $2,175.00 §$75.00 $2,175.00
07300220 | Project administrator 29.00 §4,000.00 §$116,000.00 §4,000.00 §116,000.00
01300230 | Project director 29,00 $10,000.00 §290,000.00 §10,000.00 §290,000.00

1300 240 Praiert enninesr 2000 £5 50000 €154 500NN €5 50000 £150 500NN
§17,097 832.54

aseqele] 15

Direct Cost: $17,997,832.54, $0.00 / SF Total Cost: $18,786,397.37, $0.00 / SF
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Q Alternates

The Alternates environment may be used for the following scenarios:

« Alternates

« Value Engineering (VE)

» Cost Escalation

* Customer Wish Lists
 Internal What If Scenarios
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\Alternates User Interface Walk-through

DESTINI Estimator - Allison Lewis-Training Estimate [Initial]

Home Project Estimate Rates & Resources Dashboard Insert View Comparison Takeoff

;J c N ';/ D) = Leii lo; E Selected Layout

Save 1 Refresh Line Fees WBS Highlight Audit From Estimate Upload to = Create System - MF - s‘;&. -— 7
Change ltem~ Properties Rules Trail View~ Financials Project ;

Estimate Other Excel Report Rate Tables Procore Bid Day Estimate Layouts

Estimate

« Base Estimate

|System 2 || Masterformat Level 1 = ‘ Masterformat Level 2 = l Masterformat Level3 = ‘

U se r I nte rface f J Iltem Number - | Description ‘ Quantity ‘ Unit of Measure | Unit Cost | Aggregate Cost \ Cost / Unit Unit Reference I Estimator

4 Building 1 $20,286,616.7... #
w al k_ th r o u h 4 0100 00 GENERAL REQUIREMENTS $568,200.000 +'
g 4 0130 00 Administrative Requirements $384,000.000 /

4 0131 00 Project Management and Coordination $384,000.000 /

01300.240 Project engineer $6,000 $72,000.000 Total Building Area | Allison Lewis
01300.250 Project executive $16,000 $192,000.000 52 Total Building Area  Allison Lewis
01300.260 Project manager $10,000 $120,000.000 Total Building Area  Allison Lewis
4 0150 00 Temporary Facilities and Controls $184,200.000
4 0152 00 Construction Facilities $34,200.000
01500.280 Office - furniture $6,000.000 Total Building Area | Allison Lewis

$20,286,616.755

Direct Cost: $20,286,616.755 $202.87/sq ft | Total Cost: $23,021,617.579 $230.22/sq ft

v Alternates Direct Cost: $0.000 $0.00/sq ft | Total Cost: $0.000 $0.00/sq ft
Project Total Direct Cost: $20,286,616.755 $202.87/sq ft | Total Cost: $23,021,617.579 $230.22/sq ft

Estimate
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« Step 1: Click the Add Alternate button to add an Alternate. Step 3: Click the Add Alternate button.

« Step 2: Fill out the row with the following data:
* Number: 001
« Name: Premium Wall Covering
» Description: Decorative Wall Covering/Mural

» Step 4: Fill out the row with the following data:
* Number: 002
« Name: Flooring

« Description: Client request to price carpet tile in lieu of
wood flooring

n

~ Base Estimate Direct Cost: $281,587.23 $0.00/sq ft | Total Cost: $347,957.02 $0.00/sq ft

~ Alternates
m Closed © Add Altemnate B Seifings
Status Number Name Description Direct Cost Total Cost Comments =
Pending | 001 Premium Wall Covering S ECUETENEE s A PRy $0.00 $0.00 ©)
Pending | 002 Carpet Flooring Sttt dinn i $0.00 $0.00 ©)
Direct Cost: $0.00 $0.00/sqft | Total Cost: $0.00 $0.00/sq ft
Project Total

Direct Cost: $281,587.23 50.00/sq ft | Total Cost: $347,957.02 50.00/sq ft

-t | Estimate | Rates 8 Resources Dashboard Companson Takeoff
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» Step 5: Open the Alternate via the Open button.

. S’cepI 6: Go to Cost Database and search for “097216.0100 - Vinyl wall covering; medium duty” — Double-click to add
to alternate

« Step 7: Qty = 228 sf in estimate view

« Step 8: Return to Alternate Summary and Open Alternate “002 — Carpet Flooring”

« Step 9: Go to Cost Database and search for “096813.0100 - Carpet; tile” — Double-click to add to alternate

« Step 10: Qty = 7,500 sf in estimate view

« Step 11: Go to Cost Database and search for “096429.0145 - Wood flooring; engineered wood flooring” — Double-
click to add to alternate

« Step 12: Qty =-7,500 sf in estimate view

« Step 13: Return to Alternate Summary
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« Step 16: Go to Estimate View > Alternates Section
« Step 17: Pin closed the Cost Information View in order to see the full Alternate detail.

« Step 18: Note the Direct Cost and Total Cost displayed in the Alternates header bar, but it is not included in the Alternates Total.
Remember: only Accepted Alternates will populate the footer.

« Step 19: Go up to the Alternates Summary displayed in the Details view and click on the left arrow (back button) on the left side of the
screen to go back to the full Summary.

Estimate ®
¥ Base Estimate Direct Cost: $595,473.26 $5.95/sq ft I Total Cost: $676,777.90 $6.77/sq ft |
Status Number Name Description Direct Cost | Total Cost | mments | Type
(© [ Pending | 001 Premium Wall Covering Decorative Wall Covering/Mural +$798.98 +$915.09 003 Owner Wish-lis Ti] v
Syst: -~ ~
\ Masterformat Level 1 H Masterformat Level 2« ” Mo eonnat Lo A ‘ Q
I ltem Number - ’ Description | Quantity ‘ Unit of Measure Unit Cost Aggregate Cost | Cost / Unit | Unit Reference I Estimator
4 Building 1 $798.98 » =
4 0900 00 Finishes $798.98
4 09 70 00 Wall Finishes $798.98
4 09 77 00 Special Wall Surfacing $798.98
09700.010 Wall covering - fabric 228 sf $3.50 §798.98 $0.01 Total Building Area  Allison Lewis
v
£798.98
I Direct Cost:  $000 $000/sq ft | TotalCost:  $0.00 $0.00/sqft I
Project Total - Direct Cost: $595,473.26 $5.95/sq ft l Total Cost: $676,777.90 $6.77 /sq ft

Project | Estimate | Rates & Resources Dashboard Comparison Takeoff
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\Moving a Line Item from Base Bid

Estimate
« Base Estimate

ACer nera

| tem Number = | Description

N8 AN AN

Navigate to Estimate window

Remove Cost
Copy Line ltem
- Right click on line item you wish to move Paste Line ftem
Move to...
. " View Audit Trail
- Hover over "Move to... RN
oggle Line ltem Roll Up
- Select the Alternate you wish to move line item to Switch to Metric

Switch to Impenal

* Alternates

Cluantity Unit of Measure

001 - Premium Wall Coverings
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. Indirect Costs (examples)

- lnsurances

o laxes
- Bonds
o Fee

o Contingencies

o Calculations based on specific scopes of work
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\ Fee Table — Create one!

[3 Fees Editor O bt

Direct Cost:
Mame | Direct Cost | Fee Total | Total Cost | $15,588,062.70
Base Estimate Fee $15,588062.70 $161519600 $17.203 25878 | S Insert Fee | | = Insert Total | Distributed Direct Cost:  §15,588,062.70

Final Total:  $17,203,258.78

Mumber | Alternate Mame | Direct Cost Fee Total |T|::taE Cost Fee Type On | MName |T',-.-'PE Cost Basis Amount Fee TI:-tall Distribute

001 Premium Wall C... §8,758.84 $93.30 $8,852.14 | Custom ¥| | General Conditions Percent * | Direct 5.00% 5779,403.13
002 Floaring 50.00 50.00 $0.00 Base GC Subtotal Subtatal - $16,367,465.92 €
General Liability Percent * | GC Subtotal $81,837.33
Excess Liability Percent GC Subtotal $81,837.33
Subtotal Running Tatal $16,531.140.49 ﬁ'

Fee Percent Subtotal 3.50% 5578,589.92
P&P Bond Per Value Direct $£6.00/%1,0... $ 593,528.38

Mowve Down

Delete
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\Alternates Fee Table — Create one!

E Fees Editor

Direct Cost: $8,758.84

Mame | Direct Cost | Fee Total | Total Cost |
Base Estimate Fee $15,588,062.70 £1615196.00 | $17.203,258.78

| % Insert Fee | | = Insert Total | Distributed Direct Cost: §8,758.84

Final Total: $8.852.14

On | Mame |Type Cost Basis Amount Fee Tﬂtﬂ|| Distnibute

Number |Alternate Name | Direct Cost | Fee Total |TDtai Cost | Fee Type

001 Premiurm Wall C... §8,758.84 £93.30 §8,852.14 Custom W | | Artist Fee Percent
50.00 | Base v| | Interior Design Fee Percent v | Compounding 20.00% $75.36

* | Custom 5.00% |, £17.94

002 Flooring 50.00 50.00
Wall Covering Fee Subtotal Subtotal - 5452.14 0

Mowve Down

Delete

(X
Delete All
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‘ Deliverables

Reports Dashboards




SscCK TeCH

. Report Files in Z Drive
- Master Files in one location
- All Users — Edit Preferences to read the proper folder
- Run via Dropdown on HOME tab

. Find and Run Report Button
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. Run Owners Report and Self-Perform Report
. Report Viewer

- Test parameters to become familiar with function

- SUBMIT after any changes to see modifications in report
. Exporting PDF

- Save to Local Machine
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. Standard Dashboards
- Review Summary Dashboard
Select WBS breakdown
Filter S0.00 Costs
- Review System Breakdown
Select WBS breakdown
Select Systems Left to Right
Filter S0.00 Costs
. Print from Estimator OR save out to Excel to adjust print parameter

. Discuss Estimate Comparison & Alternate Summary Reports
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Close out of project

Go to Recent estimates

Click ellipsis and create a version
Previous version is CLOSED for edits
New version is editable

Unlimited versions from closed estimates
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Q\ Resources

Beck Technology Support - support@beck-technology.com

-Urgent Support

- Examples: unable to launch the application, unable to acquire a license, unable to save an estimate, unable to print a report, application
hangs/crashes, etc.

Help Center - howto.beck-technology.com/knowledge
- Articles and FAQs for all DESTINI products

Beck Teck Training Portal - becktechnologytraining.lessonly.com/learn

- Basic Training
- Online training
- Review the basics or learn new topics

Customer Success - Customersuccess@beck-technology.com

- Fastest way to contact your Beck Tech rep with product questions post-implementation



mailto:Support@beck-technology.com
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mailto:Support@beck-technology.com
https://becktechnologytraining.lessonly.com/learn
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